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Preface

Simulink, developed by The MathWorks, is a commercial tool for modeling, simulating and
analyzing dynamic systems. Its primary interface is a graphical block diagramming tool and a
customizable set of block libraries. It offers tight integration with the rest of the MATLAB
environment and can either drive MATLAB or be scripted from it. Simulink is widely used in
control theory and digital signal processing for simulation and design.

This training will give you the basic knowledge of Simulink and how you can use it together
with MATLAB.

Available Online:

https://www.halvorsen.blog/documents/programming/matlab/matlab mic.php

For more information about MATLAB and Simulink, see my Blog:

https://www.halvorsen.blog
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1Introduction to Simulink

Simulink is an environment for simulation and model-based design for dynamic and
embedded systems. It provides an interactive graphical environment and a customizable set
of block libraries that let you design, simulate, implement, and test a variety of time-varying
systems, including communications, controls, signal processing, video processing, and image
processing.

Simulink offers:

e A quick way of developing your model in contrast to text based-programming
language such as e.g., C.

e Simulink has integrated solvers. In text based-programming language such as e.g., C
you need to write your own solver.



2 Start using Simulink

You start Simulink from the MATLAB IDE:

Open MATLAB and select the Simulink icon in the Toolbar:

) MATLAB 7.4.0 (R2007a)

File Edit Debug Deskiop Wit
Dw|% @ of Y@@
Shortcuts (2] How to Add (2] Whal
Current Directory * 0 2 x |Co d Histo [Command Window BRI Workspace »0 2 x
Bkl B - (@ To get started, select MATLAB Help or Demos from the Help menu, (b HBPM-E ]
All Files + Type Size | Date Modi (o e
“Jlinsolution.m M-file 1KB 15.10.09 This is a Classroom License for instructional use only.
“) simple.m M-file 1KB 221009 Research and commercial use is prohibited.
) Test_itm M-file 1KB 151009 | | 517;: added paths for Simulation Interface Toolkit Version 2009
€1 TestCase.m M-fle TKB 151009 | 5o oreing the SIT Server on port 6011
) TestForLoop.m M-file 1KB 15.10.09 || 517 server starced
) TestLU.m M-file 1KB 151009 || 7
) TestWhile.m M-file 1KB 15.10.09
< i > < >
4 Start| Ready ER
“w_s . ” - . . .
Or type “simulink” in the Command window, like this:
[Command Window wnga X
X

o To get started, select MATLAB Help or Demos from the Help menu.

This is a Classroom License for instructional use only.
Research and cormmercial use is prohibited.
SIT: Added paths for Simulation Interface Toolkit Version 2009
Starting the SIT Server on port 6011

>>

Then the following window appears (Simulink Library Browser):




Start using Simulink

=1 Simulink Library Browser.
File Edit Yiew Help

D& = 4|

Commonly Used Blocks: simulink/Commonly

Used Blocks

B simulink
2| Commonly Used Blocks
2 Continuous
2+ Discontinuities
> Discrete
2+ Logic and Bit Operations
2+ Lookup Tables
- Math Operations

u’;‘;’g’ﬂ%‘;‘k Commonly Used Blocks

Continuous

Discontinuities

= F

Discrete
2+ Model Verification
2 Model-Wide Utilities =
g‘ I b I” &Iil >=| Logic and Bit Operations
2 Ports & Subsystems =
2| signal Attributes
2] Signal Routing Lookup Tables
2| Sinks
2 Sources Math Operations

2 User-Defined Functions

+- 2| Additional Math & Discrete
B Control System Toolbox

B Data Acquisition Toolbox
B Fuzzy Logic Toolbox
B Model Predictive Control Toolbox
B NI SIT Blocks
B neural Network Toolbox

Model Verification

[+
LM E

Misc Modelwide Utilities

JL F
Ports & Subsystems
c 4

User-Defined Functions

X
i 2
+ WA Real-Time Workshop h Signal Attributes
+- T Simulink Control Design
+- W Simulink Extras '.Iz Signal Routing
+- g Simulink Response Optimization
v
B stateflow _}L:’_ Sinks
+- T System Identification Toolbox Lokl
Virtual Reality Toolbox b
+ W i s T’ Sources
.

Additional Math & Discrete

JReady

The Simulink Library Browser is the library where you find all the blocks you may use in
Simulink. Simulink software includes an extensive library of functions commonly used in
modeling a system. These include:

e Continuous and discrete dynamics blocks, such as Integration, Transfer functions,
Transport Delay, etc.

e Math blocks, such as Sum, Product, Add, etc

e Sources, such as Ramp, Random Generator, Step, etc

2.1 Block Libraries

Here are some common used Continuous Blocks:

1; Intearator

Tutorial: Introduction to Simulink



Start using Simulink

® = AoctBu
y = Cx+Du

State-Space

Transfer Fen

Transport Delay

Here are some common used Math Operations Blocks:

&

Add

> Gain

Product

Sum

Here are some common used Signal Routing Blocks:

I Mux
I Demux

Here are some common used Sinks Blocks:

]

Scope

XY Graph

Here are some common used Sources Blocks:

il

oooo
fele]

/

Step

Signal Generator

Ramp

Tutorial: Introduction to Simulink



5 Start using Simulink

M Random Number

1 Constant

In addition there are lots of block in different Toolboxes:

+- 2| Additional Math & Discrete
w
B Data Acquisition Toolbox
B Fuzzy Logic Toolbox
B Model Predictive Control Toolbox
B4 NI SIT Blocks
B neural Network Toolbox
B Real-Time Workshop
B simulink Control Desian
B Simulink Extras
§| Simulink Response Optimization
B stateflow
B System Identification Toolbox
+- W virtual Reality Toolbox

+

][] [ ][]

+

+

2.2 Create a new Model

Click the New icon on the Toolbar in order to create a new Simulink model:

=1 Simulink Library Browser

File Edit Yiew Help

ression for zeros. Vector expressior
Create a new model|, or one if zeros is a vector.

The following window appears:

Tutorial: Introduction to Simulink



6 Start using Simulink

File Edit View Simulation Format Tools Help
bDEeE& A<= = 4|2 & 1 100 [Nomal  ~|| 33§
JReady 100% odedS

You may now drag the blocks you want to use from the Simulink Library Browser to the
model surface (or right-click on a block and select “Add to...”).

In this example we place (drag and drop) to blocks, a Sine Wave and a Scope, on the model
surface:

FJ untitled *

File Edit WYiew Simulation Format Tools Help
O EeEES R &E= (22 p = |1U.D INormaI LI
a ]
W
Sine Wave Scope
Ready 100% odedS Y/

2.3 Wiring techniques

Use the mouse to wire the inputs and outputs of the different blocks. Inputs are located on
the left side of the blocks, while outputs are located on the right side of the blocks.

Tutorial: Introduction to Simulink



7 Start using Simulink

Inputs 4 xol— 3

Integratort

' % Output

Constant1

When holding the mouse over an input or an output the mouse changes to the following
symbol.

Use the mouse, while holding the left button down, to drag wires from the input to the
output.

Automatic Block Connection:

Another wiring technique is to select the source block, then hold down the Ctrl key while
left-clicking on the destination block.

Try the different techniques on the example above.

Connection from a wire to another block

If wire a connection from a wire to another block, like the example below, you need to hold
down the Ctrl key while left-clicking on the wire and then to the input of the desired block.

A 1] A 1]
L4
Y, > ¥,
Sine Wave Scope Sine Wave Scope
a
J BN [
Scope Scope

2.4 Help window

In order to see detailed information about the different blocks, use the built-in Help system.

Tutorial: Introduction to Simulink



8 Start using Simulink

=] Function Block Parameters: Integrator @

Integrator

Continuous-time integration of the input signal.

Parameters
External reset: |n0ne v |
Initial condition source: ’intemal v|

Initial condition:

0 |
[] Limit output

Upper saturation limit;

linf |

Lower saturation limit:
[-inf |

[] Show saturation port
[] Show state port
Absolute tolerance:

\auto

[] Ignore limit and reset when linearizing
Enable zero crossing detection

State Name: (e.q., 'position’]

’u

0K H Cancel ﬂ Help ) Apply

—

All standard blocks in Simulink have detailed Help. Click the Help button in the Block
Parameter window for the specific block in order to get detailed help for that block.

The Help Window then appears with detailed information about the selected block:

Tutorial: Introduction to Simulink



9 Start using Simulink

elp m|
File Edit View Go Favorites Desktop Window Help El
Help Navigator Xl|lawp 2 & #
Search for: [ v‘ Title: l Integrator :: Blocks {Simulink) v‘
Example: "plot tools" OR plot* tools
Contents {lndex | Search Results | Demos Simulink [« @
5 & Simulink || Integrator J
# O Getting Started Integrate signal
-ig- Examples N
#-[B) How Simulink Works Library

w-[@ Simulink Basics

w-[B) Creating a Model

-3 Working with Blocks

- [B Working with Signals
#-[@ Using Composite Signals
w-[F Working with Data

Continuous

Description

#-1EF) Working with Lookup Tables The Integrator block outputs the integral of its input at the current time step. The following eguation
3 Modeling with Simulink represents the output of the block y as a function of its input u and an initial condition yo, where y and u
@-[B Exploring, Searching, and Browsing Mod are vector functions of the current simulation time t.
@ Running Simulations :
3 @ Analyzing Simulation Results yit) = J't u(Hydt +yg
@[3 Creating Block Masks °
[+ @ Simulink Debugger — Simulink can use a number of different numerical integration methods to compute the Integrator block's
@[ Simulink Accelerator output, each with advantages in particular applications. The Solver pane of the Configuration
#-[B) Customizing the Simulink User Interface parameters dialog box (see The Solver Pane) allows you to select the technique best suited to your
#-[B) Using the Embedded MATLAB Function application.
? PrintFrame Editor Simulink treats the Integrator block as a dynamic systern with one state, its output. The Integrator
@ block's input is the state's time derivative.
~-Continuous x =y
~Discontinuities Xp =Yg
h Dlst?rate ) ) ¥ = ul)
+~Logic and Bit Operations
+-Lookup Tables The currently selected solver computes the output of the Integrator block at the current time step, using
~Math Operations ~ | | the current input value and the value of the state at the previous time step. To support this computational
< > model, the Integrator block saves its output at the current time step for use by the solver to compute its

2.5 Configuration

There are lots of parameters you may want to configure regarding your simulation. Select
“Configuration Parameters...” in the Simulation menu.

le Edit View ma@ Format Tools Help

I =2 g é Start Chrl+T

| Configuration Parameters... Ctrl+E

v Mormal
External

The following window appears:

Tutorial: Introduction to Simulink



10 Start using Simulink

*4 Configuration Parameters: Example2/Configuration (Active) @

Select: Simulation time
- Solver ‘ " 2
Start time: |[L{8 Stop time:|10.0
- Data Import/Export ! E ‘ Pl | l
-~ Optimization Solver options
[=1- Diagnostics
ample Time Type: Variable-step v ‘ Solver: [ode45 [Dormand-Prince) v]
ata Validity ) Max step size: auto ‘Relative tolerance: [1 ed ]
e Cop\_/ersmn Min step size: auto ‘Absolute tolerance: [auto ]
onnectivity » i [
ompatibility Initial step size: auto ‘
---- Model Referencing Zero crossing control:|Use local settings v‘

- Hardware Implementation
- Model Referencing
=-Real-Time Warkshop Solver diagnostic controls

[] Automatically handle data transfers between tasks

Number of consecutive min step size violations allowed: h ‘

Consecutive zero crossings relative tolerance: [1 0+128%eps ]

Number of consecutive zero crossings allowed: |1 i} ‘

0K l [ Cancel ] [ Help Apply

Here you set important parameters such as:

e Start and Stop time for the simulation
e What kind of Solver to be used (ode45, ode23 etc.)
e Fixed-step/Variable-step

Note! Each of the controls on the Configuration Parameters dialog box corresponds to a
configuration parameter that you can set via the “sim” and “simset” commands. You will
learn more about these commands later.

Solvers are numerical integration algorithms that compute the system dynamics over time
using information contained in the model. Simulink provides solvers to support the
simulation of a broad range of systems, including continuous-time (analog), discrete-time
(digital), hybrid (mixed-signal), and multirate systems of any size.

2.6 Examples

Below we will go through some examples in order to illustrate how to create block diagrams
and related functionality.

Example: Integrator with initial value

Create the following model (an integrator) and run the simulation:

Tutorial: Introduction to Simulink



11 Start using Simulink

] Integrator

File Edit Yiew Simulation Format Tools Help
D B" E é = = 1l L I |1 0.0 INormaI ﬂ
™ 1
o |
1 | Integrator Scopet
Constant
Ready 100% ode4S

Step1l: Place the blocks on the model surface

This example use the following blocks:

1
T Integrator
1 Constant
] Scope

Step 2: Configuration

1; Intearator

Double-click on the Integrator block. The Parameter window for the Integrator block
appears:

Tutorial: Introduction to Simulink



12 Start using Simulink

5] Function Block Parameters: Integrator @

Integrator

Continuous-time integration of the input signal.

Parameters

External reset: [none v]
Initial condition source:
[ Limit output

Upper saturation limit:
[ inf ]
Lower saturation limit:
[ -inf ]

[[] Show saturation port
[[] Show state port
Absolute tolerance:
|auto

[ Ignore limit and reset when linearizing
Enable zero crossing detection
State Name: [e.q.. 'position’]

I 0K ” Cancel ][ Help ][ Apply ]

Select “Initial condition source=external”. The Integrator block now looks like this:

| =

1 Constant

Double-click on the Constant block. The Parameter window for the Constant block appears:

E} Source Block Parameters: Constant @

Constant

Output the constant specified by the 'Constant value' parameter. |f 'Constant value' is
a vector and 'Interpret vector parameters as 1-D' is on, treat the constant value as a
1-D array. Otherwise, output a matrix with the same dimensions as the constant
value.

Main | Signal Data Types \

onhstant value:
/. |

Interpret vector parameters as 1-D

Sampling mode: |5 ample based ‘

Sample time:
lnf |

oK ] [ Cancel ] [ Help ]

Tutorial: Introduction to Simulink



13 Start using Simulink

In the Constant value field we type in the initial value for the integrator, e.g., type the value
1.

Step 3: Wiring

Use the mouse to wire the inputs and outputs of the different blocks.

i Output

Constant1

1
Inputs J%s P

Integrator1

When holding the mouse over an input or an output the mouse change to the following
symbol.

Draw a wire between the output on the Constant block to the lower input in the Integrator
block, like this:

)
: P

i ik
J Integratort
—

1

Constant1

You could also do like this:

J Automatic Block Connection Tip Q@@

To quickly connect blocks, select the source block(s], then hold
down the Ctrl key while left-clicking on the destination block.

[:] Do not show this message again

[ Help ] [ Close ]

Wire the rest of the blocks together and you will get the following diagram:

Tutorial: Introduction to Simulink



14 Start using Simulink

> 1 |
*os >
] | Integrator Scope1

Constant

Step 4: Simulation

Start the simulation by clicking the “Start Simulation” icon in the Toolbar:

2o (On [y oo

s

&

Step 5: The Results

Double-click in the Scope block in order to see the simulated result:

8 LPLL AEBE B A&
4

%10
25

Time offset. 0O

Tutorial: Introduction to Simulink



15 Start using Simulink

Example: Sine Wave

Create the block diagram as shown below:

B! Example

File Edit WYiew Simulation Format Tools Help

D eEHES 2R 4T (L2 ) = |10.0

) 1 ]
- >
¥, ¥ =
Sine Wave Integrator Scope
Ready [100% ' ode4s 4

Set the following parameter for the Integrator block:

L1 Function Block Parameters: Integrator @

Integrator

Continuous-time integration of the input signal.

Parameters
External reset: [ v
Initial condition source: [internal V]

4 ] l

] Limit output

Upper saturation limit:

fint |
Lower saturation limit:

[int |

[[] Show saturation port
[ Show state port
Absolute tolerance:

[ auto

[] Iagnore limit and reset when linearizing
Enable zero crossing detection
State Name: (e.g.. 'position’)

lu

ok |[ cencel |[ Heb | sl

The result should be like this:

Tutorial: Introduction to Simulink



16 Start using Simulink

Time offset: 0

Example: Using vectors

Create the following block diagram:

1
aw o 1 ,’K. . [
Sine Wave Integrator Gain Saturation Scope

For the Gain block, type the following parameters:

Tutorial: Introduction to Simulink



17 Start using Simulink

E] Function Block Parameters: Gain @

Gain

Element-wise gain [v = K.*u] or matrix gain [y = K*u or y = uw*K].

Main | Signal Data Types | Parameter Data Types |

s Taain:
KJ3:1 10 / ‘

Multiplication: | Element-wise(K.*u) v ‘

Sample time [-1 for inherited):

a |

I oK I [ Cancel ] [ Help ] Apply

As you see, we can use standard MATLAB syntax to create a vector.

If you want to see the signal dimensions, select “Signal Dimensions” and “Wide Nonscalar
Lines” as shown here:

tion I&l Tools Help

, B2 Font... o |1 0.0 |Norma| LI
o Alianmer b
Flip Name
Flip Block Ctrl+I
Rotate Block Ctrl+R
T~ Hide Name \'
QC Show Drop Shadow - >
——] | |
1e W, Por 2 "'n Saturation
Foreground Color »
Background Color »
Screen Color »
Port/Signal Displays 4 Sample Time Colors
Block Displays » | v Linearization Indicators
Library Link Display > Port Data Types

ignal Dimensions

Storage Class
1009 v Testpoint Indicators
v Viewer Indicators

Wide Nonscalar Lines

The block diagram should now look like this:

Tutorial: Introduction to Simulink



18

Start using Simulink

8

f\v > T >IE>3K >

Sine Wave Integrator Galn Saturation

\

ope

The thick lines indicate vectors, while the number (8) is the size of the vector.

Let’s change the Saturation block:

E Function Block Parameters: Saturation @

Saturation

Limit input signal to the upper and lower saturation values.

Parameters

UpgsrTimit S\

rand8 1110\

Lower limit:

and@1)-1d  /

Treat as gain when linearizing

Enable zero crossing detection
Sample time [-1 for inherited):

Rl

l oK l [ Cancel ] [ Help

]

Apply

As you see you may use standard MATLAB functions and syntax.

Run the simulation and see the results in the Scope block.

Tutorial: Introduction to Simulink



3 Useful Features

You should know about these features in Simulink in order to take full advantage of
Simulink.

3.1 Comments/Labels

Double-click on your surface in order to write Labels or Comments in your model block
diagram.

This is a label This is also a label

nn p. A /'..I:I

Pulse // Pulse Scope

Generator ~

Double-click to create labels I Change defaultl

Block labels

3.2 Align and Distribute Blocks

You may align your blocks:

19



20 Useful Features

AWA

ne Wave

Cut

Copy !
Delete (|
Connect Blocks Scope
Create Subsystem

Look Under Mask

Teq .

Requirements >

Format
Text Alignment
Foreground Golor

ound Color

Align Top Edges
Distribute Blocks Align Centers Horizontally

Blocks »  Align Bottom Edge:

»
2
2
»

3.3 Flip Blocks

Normally the inputs are on the left and the outputs on the right, but in some cases it is
convenient to have the inputs on the right and output on the left side.

1
P = {1k

Integrator1 Integrator

In order to “flip” the input and outputs right-click on the block and select “Flip Block”.

Tutorial: Introduction to Simulink



21 Useful Features

1
IntegH Explore
Cut
Copy
Delete
Integrator Parameters...
Block Properties. ..
Linearize Block. ..
1 4
Signal & Scope Manager ...
Port Signal Properties »
Foreground Y » Flip Mame
Background Color »|  Hide Name
Flip Block Chrl+1
Help
Rotate Block Ctrl+R
Show Drop Shadow

3.4 Hide Names

Hide default labels that appear on the diagram, such as Constantl1, Integratorl, etc.

Select “Hide Names” on the “Format” menu:

n  Simulation I&I Tools Help

& & Bz pankx | |1U.D INmmal LI Isaly
— | Text Alignment >

Enable TeX Commands

Flip Mame
Flip Block Chrl+I
Rotate Block Ctrl+R

=
X I

b I’Prorjut:i

Constant1

Hide Name

Foreground Color 4
Background Color »
Screen Color 4

E:ﬂ Port/Signal Displays | G- S S a
Block Displays 4 -
itep . N K
Library Link Display 4 Productl
I az

Constant

Tutorial: Introduction to Simulink



4 Data-driven Modelling

You may use Simulink together with MATLAB in order to specify data and parameters to your
Simulink model. You may specify commands in the MATLAB Command Window or as
commands in an m-file. This is called data-driven modeling.

4.1 Command window

Example:
™ 1 3 8
v " ; ”K' t P
Sine Wave Integrator Gain Saturation
|
Zero-Order Scope
Hold

"

Zero-Order
Hold1

Note! In order to get 3 inputs on the Scope block:

Double-click on the Scope and select the Parameters icon in the Toolbar:

Parameters

Then select Number of Axes=3:

22



23 Data-driven Modelling

J ‘Scope’ parameters E]\i @
General | Data history | Tip: try right clicking on axes

@ floating scope

Time range: lauto l

Tick labels: Ibottom axis only v‘

Sampling

lDecimation v l [1 l

(o | [comeet | [ | [y |

Configure the zero-order hold blocks like this:

E} Function Block Parameters: Zero-Order Hold @

Zero-Order Hold
Zero-order hold.
Parameters

Sample time (-1 for inherited):
Ts1

l oK I[ Cancel ][ Help ] Apply

m Function Block Parameters: Zero-Order Hold1 @

Zero-Order Hold

Zero-order hold.
Parameters

Sample time [-1 for inherited):

X

I oK I [ Cancel ] [ Help ] Apply

Write the following in the Command window in MATLAB:

Tutorial: Introduction to Simulink



24

Data-driven Modelling

[Command Window

o To get started, select MATLAB Help or Demos from the Help menu.

wOa X

X

>> Ts1=0.2

Tsl =

0.2000

>> Ts2=0.5

Tsz =

0.5000

>>

Run the Simulink model from the Simulink:

o

}%l W[

We then get the following results:

Tutorial: Introduction to Simulink



25 Data-driven Modelling

Time offset. 0

4.2 m-file

It is good practice to build your in Simulink and configure and run the simulation from a
MATLAB m-file.

A Typical m-file could look like this:

Tutorial: Introduction to Simulink



26 Data-driven Modelling

= Editor - M:\Work\Training\MATLABMAN Introduction to Simulink\Code\Mass-Spring-Dam... Q@@

File Edit Text Go Cell Tools Debug Desktop Window Help N A X
DeH | aRv o (S Aeansr A0 RRE BB |
G| BB B[ -[1o [+ [+[11 [x[%2]0
1 33cript of mass-spring-damper simulator. o
2 %Hans-Petter Halvorsen. 20.11.2009
&l
4 $Modell Parameters
5 - x_init=4; %[m]. Initial position.
6 — dxdt_init=0; %[m/s]. Initial Speed.
7 — m=20; %[kg]
8 — c=4; %[N/ (m/s)]
9 — k=2:; %[N/m]
10 — t_step_F=50; %[s=]
11 = F_0=0:; %[N]
12 = F_1=4; %[N]
13
14 33imulator Settings
15 = t_stop=100; %[s]
16 = T s=t_stop/1000; (=]
17 — options=simset('solver', 'odeS', 'fixedstep', T_s):
18
19 (3tarting simulation
20 = sim{'wass_spring dawper', t_stop, options):
script Ln 16 Col 22

You use the simset command to configure your simulation parameters and the sim
command to run the simulation.

The variables you refer to in the m-file is set in the Constant value field in the Parameter
window for each block.

E} Source Block Parameters: Constant1 @

Constant

Output the constant specified by the 'Constant value' parameter. |f 'Constant value' is
a vector and 'Interpret vector parameters as 1-D' is on, treat the constant value as a
1-D array. Otherwise, output a matrix with the same dimensions as the constant
value.

Interpret vector parameters as 1-D

Sampling mode: |5 ample based ‘

Sample time:
linf |

[ oK ] [ Cancel ] [ Help ]

4.3 Simulation Commands

Tutorial: Introduction to Simulink



27 Data-driven Modelling

The most used command is:

e simset
e sim
Use these commands if you configure and run your Simulink model from a m-file.
Example:
3Simulator Settings
t stop=100; %[s]
T s=t stop/1000; %[s]

options=simset('solver', 'odeb5', 'fixedstep', T s);

%$Starting simulation
sim('mass spring damper', t stop, options);

Tutorial: Introduction to Simulink



5Hybrid Systems (continuous
and discrete)

You may mix continuous blocks and discrete blocks in the same system, so-called Hybrid
systems.

Example: Hybrid System

Create the following block diagram:

"y o 1 2 "o Tt

Sine Wave Integrator Gain Saturation
.
._’J_LL. s-i ]
Zero-Order Scope
Hold
Zero-Order
Hold1
ation I&I Tools Help
ont
B Fonte = 100 [Nomal v
J— Text Alignment »
Enable TeX Commands
Flip Name
Flip Block Chrl+I
Rotate Block Ctrl+R nl p
e
Show Mame
Show Drop Shadow ne Wave Integrator
Show Port Labels L
Foreground Color 4
Background Color »
Screen Color »
Port/Signal Displays
Block Displays
Library Link Display »|  Port Data Types

v Signal Dimensions

Starans lace
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29 Hybrid Systems (continuous and discrete)

The Block diagram now looks like this:

1 g g
ﬁ\/ > - ’\K' > %
Sine Wave Integrator Gain Saturation
b .
™
Zero-Order T scope
Hold
— |
Zero-Order
Hold1

The black color is the continuous system while the colored part (red and green) is the
discrete part of the system.
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6 Example: Mass-Spring-
Damper System

6.1 Model

In this example we will create a mass-spring-damper model in Simulink and configure and
run the simulation from a MATLAB m-file.

In this exercise you will construct a simulation diagram that represents the behavior of a
dynamic system. You will simulate a spring-mass damper system.

F(t) — cx(t) — kx(t) = m&(t)

where t is the simulation time, F(t) is an external force applied to the system, cis the
damping constant of the spring, k is the stiffness of the spring, m is a mass, and x(t) is the
position of the mass. x is the first derivative of the position, which equals the velocity of the
mass. X is the second derivative of the position, which equals the acceleration of the mass.

The following figure shows this dynamic system.

r Fit)

=l

[Figure: Wikipedia]

The goal is to view the position x(t) of the mass m with respect to time t. You can calculate
the position by integrating the velocity of the mass. You can calculate the velocity by
integrating the acceleration of the mass. If you know the force and mass, you can calculate
this acceleration by using Newton's Second Law of Motion, given by the following equation:
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31 Example: Mass-Spring-Damper System

Force = Mass x Acceleration
Therefore,
Acceleration = Force / Mass

Substituting terms from the differential equation above yields the following equation:
R
X = m( cx — kx)

You will construct a simulation diagram that iterates the following steps over a period of
time.

6.2 Simulink

Create the block diagram for the mass-spring-damper model above.

Instead of hard-coding the model parameters in the blocks you should refer to them as
variables set in an m-file.

=] Source Block Parameters: Constant E]

Constant

Output the constant specified by the ‘Constant value' parameter. |f "Constant value' is
a vector and 'Interpret vector parameters as 1-D' is on, treat the constant value as a
1-D array. Otherwise, output a matrix with the same dimensions as the constant
value.

el vector parameters as 1-D

Sampling mode: |S ample based ‘

Sample time:
linf [

[ 0K ] [ Cancel J [ Help J

These variables should be configured:

e X init

e dxdt_init
® m=

e (=

o k

o t step F
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32 Example: Mass-Spring-Damper System

6.3 m-File

The following variables should then be set in the m-file:

X init=4; %[m]. Initial position.
dxdt init=0; %$[m/s]. Initial Speed.
m=20; %[kg]
c=4; %[N/ (m/s)]
$[N/m]

F=50; %[s]

6.4 Results

The Block Diagram should look something like this:

] mass_spring_damper Q@@
File Edit Yiew Simulation Format Tools Help
DEzE& V| (2] » 10.0 Normal Y| B @) e REBE®
:l @
T+
M «
v 1
o3
JReady 100% T=0.00 ode4S

The m-File should look something like this:
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33 Example: Mass-Spring-Damper System
= Editor - M:\Work\Training\MATLAB\An Introduction to Simulink\Code\Mass-Spring-Dam... Q@@
File Edit Text Go Cell Tools Debug Desktop Window Help N A X
N H| i aRo |8 Heas Ff|AR|BRE DA | O~
(B2 8| -[1o [+ | =11 [x || @
1 33cript of mass-spring-damper sSimulator. =
2 %Hans-Petter Halvorsen. 20.11.2009
3
4 %Modell Parameters
5 X_init=4; %[w]. Initial position.
6 dxdt_init=0; %[m/=s]. Initial Speed.
7 w=20; % [kg]
g c=4; %[N/ (n/s)]
9 k=2; %[N/m]
10 t_step F=50; %[s]
11 F_0=0; 5[N]
12 F_1=4; %[I]
13
14 $3imulator Settings
15 t_stop=100; %[=]
16 T_s=t_stop/1000; %[s]
17 options=simset ('solver', 'ode5', 'fixedstep', T_s):
18
19 $3tarting simulation
20 sim('mass_spring dawper', t_stop, options):
script Ln 16 Col 22
Graphs:
Force F

SB LLL ABE

0
0 10 20 30 40 50

Time offset. 0

Position x and speed x:
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Example: Mass-Spring-Damper System

Time offset: 0

Tutorial: Introduction to Simulink



7Embedded Algorithms

This chapter explains how you incorporate an existing MATLAB function into your Simulink
model.

Make sure your MATLAB function is compiled as an embedded MATLAB function using the
#eml directive, e.g.:

H Editor - C:\IntroSL\Sampling_error.m
File Edit Text Go Cell Tools Debug Desktop Window Help

ﬁ@ﬂ[*;§®00|g|ﬁﬁﬁﬁ’.|u'
Sl | ol | o | on |l

TTEY - |
|function y = Sampling error (ul,u2)

- weights = 1./([3:1:10];

= S1 (ul. *weights') ' *ul;
= S2 (u2.*weights') ' *u2;
— y = ol = 927

WD~ b WWN
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36 Embedded Algorithms

=1 simulink Library Browser [D; [z]

File Edit View Help

0@ 4 dh |
Embedded MATLAB Function: Embedded MATLAB block

= gl Simulink :
B Commonly Uised Blocks (I TR | E mbedded MATLAB Function

%+ Continuous

(>

2 Discontinuities LO)] Fen

> Discrete

2+ Logic and Bit Operations mifile Level-2 M-file 5-Function
2 Lookup Tables

| Math Operations MATLAB | 1ati a8 Fon

| Model Verification Funetion

2| Model-wide Utilities

em [ S-Function
2 Ports & Subsystems o

2 Signal Attributes ) ) .
2] signal Routing — syzkem S-Function Builder
2| Sinks o
un .
2+ Sources Exnmplz S-Function Examples

| User-Defined Functions
- 2 Additional Math & Discrete
B Control System Toolbox
B Data Acquisition Toolbox

+- W Fuzzy Logic Toolbox v
JReady A
Drag in the Embedded MATLAB function:
N B T 8 = 8
Ll < -

Sine Wave Integrator Gain Saturation

_]—l-\_ L gC] y fon vp

Zero-Order Scope Embedded
iy MATLAB Function

‘Fl

Zero-Qrder
Hold1

Double-click on the Embedded MATLAB function give us the standard template for an
embedded function:

£y Embedded MATLAB Editor - Block: Intro_SL/Embedded MATLAB Function
Fle Edt Text Debug Toolks Window Help

D@ D2 A0 S&E »" 0B
function y = fcn(u)

This block supports the Embedded NATLAB subset.

See the help menu for details.

0O b WO -

ALY I

Modify the template so it calls your MATLAB function:
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37 Embedded Algorithms

£} Embedded MATLAB Editor - Block: Intro_SL/Embedded MATLAB Function
File Edit Text Debug Tools Window Help

function ¢ = fcn(ul,uzl)
% This block supports the Embedded MATLAB subset.

s See the help menu for details.

“n b W N -

= ¢ = Sampling error(ul,ul):’

Wire the system like this:

1 8 e 8
\ L s —DIK' >
Sine Wave Integrator Gain Saturation
g agll ] ol [ |
8 _J_‘LL fon y
copet

S
Zero-Order Scope 3
Hold Embedded
R MATLAB Function

v

Run the Simulation:

) Scopel ':‘ _I_I- m] l‘]

FETEEEN EEIEE R
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8Subsystems

You create subsystems to create hierarchical systems and hide details in the model.

Select the part of your system from which you want to create a subsystem, right-click and
select “Create Subsystem”.

1\ 1
> s
Sine Wave Integrator
Example:
[ 1
i > K >
Sine Wave Integrator Gain Saturation

TR

Zero-Order Scope
Hold

gik"

Zero-Order
Hold1

Yyy

h 4

Right-click and select “Create Subsystem”:
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39 Subsystems

Out1
\ T, 2]
Vi P In1 Out2 r:
Sine Wave Integrator Out3 . Scope
Subsystem

If we double-click on the subsystem we see the blocks in the subsystem:

o > '
I:lut1

Gain Saturation

—> L )

Zero-Order ke
Hold
8
— [
- - Out3
Zero-Order
Hold1

Right-click on the block and select “Edit Mask” in order to open the Mask Editor:

Mask Editor. : Subsystem Q@@

:l Parameters | Initialization | Documentation

r~Icon options- 1 rDrawing commands

Frame

Visible

I

Transparency

Opaque v

Fixed

o
[
b
o
o
=]
5
<

Units

Autoscale W

Examples of drawing commands

Command ’ port_label (label specific ports) v‘

Syntax  port_label('output!, 1, xy")

[ QK ][ Cancel J[ Help ][ Apply ]
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40 Subsystems

The Mask Editor allows you to change how the subsystem should look, e.g., the subsystem
icon.

.’
—» T apll]
N g
Integrator ; Scope
Subsystem
£
E4Mask Editor : Subsystem n
Icon | Parameters | Iniialization | Documentation |

~Icon options | [ Drawing commands

Frame plot (peaks);

| Visible LI

Transparency

ESTI

Set Parameters for the subsystem:
Ex Mask Editor : Subsystem e | =] B2
Icon Parameters | Initialization | Documentation |
- Dialog parameters
Prompt Variable Type Evaluate | Tunable
Sample Time 1 Ts1 edit - v v
Sample Time 2 Ts2 edit v v v

o L [ [

Double click on the sub system now gives the Parameter window for the subsystem:
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Subsystems

41
| =) Function Block Parameters: Subsystem |
~ This is my custom subsystem (mask)
This subsystem samples the signals at a specified rate
— Pacameters
" | Sample Tene 1
N o 1
Ll ; '-" - ﬂ
Sine Wave Integrator 1 | Sample Time 2
Subsystem IO
[ ok | cawe | web | ey |
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9Model Explorer

The Model Explorer allows you to quickly locate, view, and change elements of a Simulink
model or Stateflow chart.

To display the Model Explorer, select Model Explorer from the Simulink View menu.

% Model Explorer

File Edit View Tools Add Help
0@ $@@X BHERRHI 00 DE B
Search: [by Name V‘ Name: ‘ ‘ E;T Search
Model Hierarchy Contents of:  Task1_5/Subsystem1 ‘ Function Block Parameters: Subsystem1
=-[E5]Simulink Root Sub
i W Base Workspace | Name B0 VESIE o e s el
: Task1_5 21 Constant2 C
--'”Model Workspace =1 Integrator! Parameters
--v%tnnfigulation [Active) =1 Product2 Show port labels FromPortlcon
Sum1
@Cnde for Task1.5 L1 Sum " Read/\write permissions: lHeadeite
~ @ Advice for Task1_5 = int Inport -
1 outt Outport Name of error callback function:
1 In2 Inport [
Permit hierarchical resolution: [A!I v
[] Treat as atomic unit
|« | >
Contents | Search Results | Revert Apply

EBX
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10 Exercises

In this chapter we provide more exercises.

Exercise:

Build the following block diagram:

Gravity Velacity elooity 1
Position Position
981 f—1
1 q Position
o h 5 - h? =
s Veloci s
[15]

IC
Position
-0.8

Elasticity

In this exercise we will model a rubber ball that is thrown in the air with an initial velocity of
15 m/s from a height of 10 m. We will model the dynamics of the ball as it bounces, under
the influence of gravity. We will assume that 20% of the energy is lost on each bounce. (That
is, after each impact, the ball will travel at 80% of its prior velocity, but in the opposite
direction.)

We can model this example by integrating g (g = -9.81m/s”2) over time with the initial
condition set to 15 m/s. We reset the integrator each time the position reaches zero meters
and set the new initial condition to -80% of the impact velocity. Position is modeled by
integrating the velocity over time with the initial condition set to 10m/s.

The result should be:
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44 Exercises

Velocity

10

Position

Watch this video to see the result:
http://www.mathworks.com/products/demos/simulink/Simulink Key Features/videos/buil

ding.html
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